
КЛИНИЧЕСКАЯ И ЭКСПЕРИМЕНТАЛЬНАЯ МОРФОЛОГИЯ / CLINICAL AND EXPERIMENTAL MORPHOLOGY       Том 14  № 5  202578

© Буравков С.В., 2025

DOI: 10.31088/CEM2025.14.5.78-84	 УДК: 57.086.3

Применение программы ImageJ для картирования 
химических элементов методом рентгеновского микроанализа 
на сканирующем электронном микроскопе
С.В. Буравков1,2

1	ФГБОУ ВО Московский государственный университет имени М.В. Ломоносова, Москва, Россия
2 	ФГБУН Государственный научный центр Российской Федерации – Институт медико-биологических проблем РАН, Москва, 

Россия
Резюме. Введение. Картирование химических элементов методом рентгеновского микроанализа на 
сканирующем электронном микроскопе дает возможность получить информацию о химическом со-
ставе в каждой точке изображения, однако программное обеспечение электронных микроскопов не 
позволяет детально анализировать карты распределения химических элементов.
Целью исследования являлась разработка алгоритмов применения программы ImageJ для анализа 
карт распределения химических элементов шлифов бедренной кости крысы, полученных с помощью 
энергодисперсионного микроанализа на сканирующем электронном микроскопе.
Материалы и методы. Работа выполнена на бедренных костях крыс Вистар, фиксированных в 10% 
формалине и обезвоженных в спиртах возрастающей концентрации. Эпидиафизарные области монти-
ровали на углеродной ленте и заливали цианометакрилатным клеем, после чего шлифовали анализи-
руемую поверхность. Для построения калибровочной кривой внешние стандарты не использовались. 
Программное обеспечение микроскопа JCM-7000 позволяет определять процентное содержание 
элемента по прямоугольной площади изображения на карте распределения (среднее). Это же изо-
бражение использовалось в ImageJ для определения его средней яркости (уровня серого). Таким об-
разом, набрав определенное количество изображений с разными концентрациями кальция и фосфора, 
строили калибровочную кривую, где определенной концентрации элемента соответствовала яркость. 
В этом случае концентрация элементов может варьироваться от 0 до 100 процентов, а яркость от 0 
до 255 градаций (в случае 8-битного изображения).
Результаты. Показано, что, используя калибровочную кривую, можно преобразовать карту распре-
деления элементов из интенсивности яркости в концентрацию и, применяя пакет анализа изображе-
ний ImageJ, автоматизировать измерения, а также получить данные по колокализации нескольких 
химических элементов и их корреляции.
Заключение. Реализация алгоритмов, описанных в данной статье с применением программы ImageJ 
при картировании химических элементов методом рентгеновского микроанализа на шлифах костной 
ткани, значительно расширяет возможности программного обеспечения сканирующего электронного 
микроскопа и позволяет получить дополнительную информацию.
Ключевые слова: программное обеспечение ImageJ, рентгеновский микроанализ, картирование 
химических элементов, сканирующая электронная микроскопия, бедренные кости крыс
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Abstract. Introduction. Elemental mapping with X-ray microanalysis on a scanning electron microscope 
gives the information about the chemical composition at each point in the image, but the software of electron 
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Введение
Рентгеновский микроанализ – это метод аналитиче-

ской электронной микроскопии, который осуществля-
ется с помощью электронного микроскопа. Он основан 
на генерации характеристических рентгеновских лучей 
в атомах образца при взаимодействии с падающими 
электронами пучка. В результате такого взаимодей-
ствия генерируются рентгеновские лучи, являющиеся 
характеристическими, то есть содержащими инфор-
мацию о том, какие элементы присутствуют в данном 
образце. Существует множество электронных оболо-
чек и подоболочек, каждая из которых обладает своей 
определенной энергией, поэтому имеется множество 
потенциально возможных переходов электронов. Если 
электрон срывается с K-оболочки, результирующий 
рентгеновский пик называется К-линией в спектре; 
если с L-оболочки, то L-линией, и так далее. Кроме 
того, падающие электроны генерируют фоновые или 
сплошные рентгеновские лучи. Эти рентгеновские 
лучи являются тормозными, возникающими из-за вза-
имодействия падающих первичных электронов с ядром 
атома.

Как и у любого другого метода, у рентгеновского 
микроанализа существует минимальный детектиру-
емый порог, определяемый интенсивностью пада-
ющих электронов и чувствительностью детектора. 
Самая низкая концентрация элемента, которую можно 

обнаружить, составляет порядка нескольких милли-
молей на килограмм или несколько сотен частей на 
миллион, а наименьшее количество элемента – 10–18 г. 
Пространственное разрешение анализа зависит от 
толщины образца. Наилучший результат достигается 
в тонких срезах, где, как правило, диаметр анализи-
руемого объема равен примерно половине толщины 
среза. При анализе объемных образцов в сканирую-
щем электронном микроскопе пространственное раз-
решение и минимальная детектируемая концентрация 
химического элемента зависят от ускоряющего напря-
жения и состава образца. Типичное значение для ана-
лиза лиофилизированного биологического материала 
при ускоряющем напряжении 20 кВ – приблизительно 
10 мкм [1]. 

Скорость и точность анализа с использованием 
энергодисперсионной спектроскопии в сканирующем 
электронном микроскопе значительно повысились за 
последние 10 лет благодаря увеличению отношения 
сигнал/шум за счет улучшения сбора и обработки сиг-
налов.

Энергодисперсионная спектроскопия может прово-
диться в трех режимах: анализ химических элементов 
в точке, распределение элементов по линии и, наконец, 
анализ распределения по площади, или картирование. 
Последний режим наиболее интересен, поскольку 
в каждой точке имеется полный спектр, то есть все 

microscopes does not provide detailed analysis of the elemental maps. The study aimed to develop algorithms 
applying the ImageJ freeware program to analyze X-ray maps of rat femur sections obtained using energy-
dispersive microanalysis on a JCM-7000 scanning electron microscope (Japan).
Materials and methods. The research was performed on femurs of Wistar rats, fixed in 10% formalin and 
dehydrated in a graded series of alcohols. The epidiaphyseal bone regions were mounted on carbon tape and 
embedded in cyanomethacrylate glue; having been polymerized, the samples were polished and analyzed. 
No external standards were used for calibration curve construction. The microscope software enabled de-
termination of the average elemental percentage within a rectangular area of the image on the distribution 
map. The same image was processed in ImageJ to determine average brightness (gray level). Thus, having 
collected a certain number of images with different calcium and phosphorus concentrations, I constructed 
a calibration curve, where a certain elemental concentration corresponded to a specific brightness value. 
Elemental concentrations ranged from 0 to 100%, while brightness values ranged from 0 to 255 grayscale 
units (in 8-bit images).
Results. Application of the calibration curve allows to convert the element distribution map from brightness 
intensities to concentrations levels. Using the ImageJ software package, this approach allows automation of 
measurements and provides data on the colocalization and correlation of several chemical elements.
Conclusion. The algorithms described here can be effectively applied in ImageJ for elemental mapping in 
bone tissue sections using X-ray microanalysis. This approach significantly expands the functionality of 
scanning electron microscope software and provides additional essential information.
Keywords: ImageJ software, X-ray elemental mapping, electron probe microanalysis, scanning electron 
microscopy, rat femur
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присутствующие элементы. Тем не менее программное 
обеспечение электронных микроскопов не позволяет 
детально анализировать карты распределения хими-
ческих элементов.

В настоящее время при анализе различных изобра-
жений применяются многочисленные пакеты, в том 
числе свободно распространяемые. К последним от-
носится и широко используемая научными сотрудни-
ками программа для анализа изображений ImageJ (NIH, 
США), написанная на языке Java, благодаря чему она 
является кроссплатформенной, то есть может быть 
задействована в среде разных операционных систем. 
Благодаря свободному распространению программы 
многие пользователи написали к ней различные мак
росы и плагины, значительно расширяющие ее воз-
можности. Изначально программа была разработана 
W. Rasband в 1987 году для пользователей Macintosh 
и называлась NIH Image [2], в 1997 году она была пере-
делана под Java и названа ImageJ [3].

В связи с этим целью исследования являлась раз-
работка алгоритмов применения программы ImageJ 
для анализа карт распределения химических элемен-
тов в шлифах бедренной кости крысы, полученных с 
помощью энергодисперсионного микроанализа на ска-
нирующем электронном микроскопе JCM-7000 (JEOL, 
Япония).

Материалы и методы
Исследования выполнены на крысах-самцах линии 

Вистар массой 200–250 г. При проведении исследова-
ний автор руководствовался положениями Европейской 
конвенции по защите позвоночных животных, исполь-
зуемых для экспериментов или в иных научных целях, 
а также правилами проведения работ с использованием 
экспериментальных животных. Исследование одобрено 
комиссией по биомедицинской этике Института меди-
ко-биологических проблем РАН (протокол № 515 от 
10.06.2019).

Животных под изофлурановым наркозом декапи-
тировали, извлекали бедренную кость и фиксировали 
в 10% формалине. После обезвоживания в спиртах 
восходящей концентрации ее высушивали на воздухе 
при комнатной температуре. Эпифизарно-диафизарную 
часть кости монтировали на углеродную ленту с по-
мощью цианометакрилатного клея, после чего шли-
фовали серией абразивной наждачной бумаги (марки 
3М до P2500 с размером зерна 3–5 мкм) в продольном 
направлении до срединной части, используя микро-
пылесос для удаления мелких остатков. Как показало 
проведение предварительного микроанализа, циано-
метакрилатный клей не вносит дополнительных хими-
ческих элементов, кроме углерода и азота. Для снятия 
электростатического заряда использовали незначитель-
ное напыление золотом, которое не детектировалось 
при анализе.

Подготовленные таким образом образцы (рис. 1 А) 
анализировали в настольном сканирующем электрон-

ном микроскопе JCM-7000, оснащенном энергодиспер-
сионным спектрометром, при ускоряющем напряжении 
15 кВ. Карты распределения химических элементов 
(углерод, кальций, фосфор, сера) регистрировали при 
накоплении 20 кадров и разрешении 512 × 384 точек 
(8 или 16 бит на точку). Количественный анализ про-
водили без применения стандартов с использованием 
ZAF-коррекции, встроенной в программное обеспече-
ние микроскопа.

Для построения калибровочной кривой внешние 
стандарты не использовались. Программное обеспе-
чение микроскопа позволяет определять процентное 
содержание элемента по прямоугольной площади изо-
бражения на карте распределения (среднее). Это же 
изображение использовалось в ImageJ для определе-
ния его яркости. Таким образом можно было набрать 
определенное количество изображений с разными 
концентрациями кальция и фосфора и построить ка-
либровочную кривую, где определенной концентра-
ции элемента будет соответствовать яркость. В этом 
случае концентрация элементов может варьировать от 
0 до 100%, а яркость – от 0 до 255 градаций (в случае 
8-битного изображения).

Статистический анализ и анализ колокализации 
кальция и фосфора проводили встроенными в програм-
му ImageJ средствами. Для вычисления коэффициен-
тов линейной регрессии использовали Excel (Microsoft, 
США).

Результаты
Сбор и обработка результатов картирования хими-

ческих элементов на сканирующем электронном мик
роскопе JCM-7000 осуществляются с использованием 
программы SMILE VIEW™ Lab (JEOL, Япония), одна-
ко ее возможности в анализе карт сильно ограничены. 
Представление результатов концентрации элементов 
производится с 8-битной (256 градаций) или 16-битной 
(65 536 градаций) шкалой яркости. 

В настоящее время программа ImageJ и ее клон FIJI 
являются самой распространенной свободной програм-
мой для анализа изображений, имеющей более 31 ты-
сячи публикаций в PubMed.

В данной работе использовались 8-битные карты 
распределения кальция и фосфора, полученные на 
шлифах эпифизарно-диафизарных частей бедренных 
костей крыс. На рисунке 1 B показано, что концентра-
ция кальция значительно различается в разных участ-
ках кости, и это отражается по разной интенсивности 
яркости на изображении. С помощью макросов можно 
сегментировать определенные зоны для получения ко-
личественных данных по содержанию кальция в этих 
областях (рис. 1 С). Эти макросы включают в себя 
сегментирование по уровню яркости, подсчет частиц 
с ограничением по площади и расчет концентрации 
в соответствии с полученной калибровкой. Необходимо 
отметить, что калибровочные кривые должны соответ-
ствовать битности изображений: 8-битные калибровки 
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должны использоваться для 8-битных изображений, а 
16-битные – для 16-битных изображений. Для сегмен-
тирования кальциевых карт распределения использова-
на следующая последовательность операций: 

File→Open→Image→Adjust→Color 
Threshould→Brightness→Analyze→
Analyze→Particles→(size pixel, show (overlay 
masks)→Results→Edit→Apply Macro (ConcCa.txt)

Результаты, полученные в единицах яркости, в кон-
це преобразовывались коротким макросом в концен-
трацию:

ConcCa.txt
Conc=0.38*Mean(row*0.1);
StdDevConc=0.38*StdDev(row*0.1);
MinConc=0.38*Min;
MaxConc=0.38*Max;

После сегментирования изображения и выполнения 
макроса при заданных параметрах выделяются семь 
областей (рис. 1 С). Интересующую зону можно вы-
делять и вручную, как это представлено на рисунке 1 D, 
однако сделать это труднее, особенно если она имеет 
сложную конфигурацию. 

На рисунке 2 A представлена калибровочная кривая 
для 8-битного варианта, где показана зависимость зна-
чения яркости от процентной концентрации кальция. 
Можно видеть линейную зависимость (r=0,996) вида  
y = 0,3778 × x, где y – концентрация кальция в про-
центах, а x – уровень яркости, соответствующий этой 
концентрации. Таким образом, простым перерасче-
том можно переходить от яркости на концентрацию 
(рис. 2 В). Сравнивая результаты ручного и автоматиче-
ского выделения, можно видеть, что показатели очень 
близки (рис. 2 C). 

Использование плагина колокализации (Colocali
zation Finder) дает возможность получить данные о 

Рис. 1. 	Картирование кальция в шлифах бедренной кости крыс.
	 A – общий вид смонтированной кости на предметном столике в микроскопе, B – количественное распределение кальция 

в процентах, выводимое на микроскопе, C – сегментирование распределения кальция в программе ImageJ для выделения 
и расчета концентраций кальция в определенных областях кости, D – ручное выделение необходимой области.  
Длина маркерной линии – 5 мм (А) и 1 мм (B)

Fig. 1. 	Calcium mapping in rat femur polished surface.
	 A – general view of the mounted bone on the microscope stage, B – quantitative calcium distribution (in percents) displayed 

on the microscope, C – segmentation of calcium distribution map in the ImageJ program to define and calculate calcium 
concentrations in certain bone areas, D – manual selection of the required area. Scale line – 5 mm (A) and 1 mm (B)
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взаимной локализации двух химических элементов. 
Так, например, на рисунках 3 A и B представлены 
карты распределения фосфора и кальция в шлифе 
бедренной кости крыс. Композитное изображение 
распределения фосфора и  кальция свидетельству-
ет о высокой степени наложения обоих химических 
элементов (рис. 3 С), что наглядно видно на графи-
ке рассеяния (рис. 3 D). Можно отметить, что точки 
группируются вдоль оси под углом 45°, и это свиде-
тельствует о высокой степени наложения обоих хими-
ческих элементов. Количественные данные (рис. 3 Е) 
также указывают на прямую связь между распреде-
лением фосфора и кальция (коэффициент Пирсона  
равен 0,929). 

Все карты в рентгеновской энергетической спект
роскопии регистрируются одновременно точка за 
точкой, поэтому они являются инцидентными и пред-
ставлены двумерной матрицей концентрации. Это 
дает возможность проводить корреляционные ис-
следования распределения различных химических 
элементов. Одна из ранних работ по обработке изо-
бражений в рентгеновском микроанализе появилась 
в 1989 году [4]. Первые коммерческие анализаторы 
изображений (IBAS, Kontron, ФРГ) позволили рас-
ширить аналитические возможности рентгеновского 
микроанализа в электронной микроскопии, однако 
элементные карты регистрировались на фотопленке, 
что требовало совмещения их при вводе в компьютер 

через телекамеру. Кроме того, они представляли собой 
только качественные бинарные изображения, где плот-
ность расположения точек соответствовала большей 
или меньшей концентрации. 

В настоящем исследовании были использова-
ны количественные карты распределения химиче-
ских элементов, полученные на микроскопе JEOL, 
JCM‑700, оснащенном рентгеновским спектрометром. 
Программное обеспечение ImageJ позволило реали-
зовать алгоритмы сегментирования изображений для 
выделения и измерения интересующих областей, а 
также провести оценку колокализации и корреляции 
двух карт распределения между собой. Кроме того, ис-
пользование сторонних программ для обработки карт 
дает возможность разнести сбор данных и их обра-
ботку. Такой же подход был реализован A. LeFurgey 
et al. [5] в 1991 году. Это дает возможность исследо-
вать микрохимический состав клеток в сфере клеточ-
ной физиологии с прицелом на ионную (элементную) 
компартментализацию, то есть морфофункциональную 
корреляцию структуры и функции на клеточном и суб-
клеточном уровне. 

Схожий с нашим подход был применен K.V. Dahl 
et al. [6] в 2007 году для построения количественных 
профилей химических элементов. Авторы использо-
вали данные, полученные из калибровочной кривой 
для преобразования яркости на элементных картах 
в концентрацию.

А B
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Рис. 2. 	Преобразование уровней яркости в концентрации кальция с использованием программы ImageJ.
	 A – калибровочная кривая, построенная на областях с известными концентрациями кальция, B – результаты преобразования 

уровней яркости в концентрации в областях, выделенных с помощью программы ImageJ на рис. 1 C, C – результаты ручного 
выделения области 7

Fig. 2. 	Transformation of gray levels into calcium concentrations using the ImageJ software.
	 A – calibration curve constructed on the areas with known calcium concentrations, B – results of transforming brightness levels 

into concentrations in the areas selected using the Image J software in Fig. 1C, C – results of manual selection of area 7
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Рис. 3. 	Колокализация распределения фосфора и кальция в шлифах бедренной кости крыс.
	 A – карта распределения фосфора, B – карта распределения кальция, C – совместные места распределения фосфора 

и кальция на карте (совместные места присутствия фосфора и кальция представлены желтым цветом), D – диаграмма 
рассеяния колокализации фосфора и кальция, E – количественные данные критерия Пирсона для колокализации 
фосфора и кальция. Длина маркерной линии – 2 мм

Fig. 3. 	Colocalization of phosphorus and calcium distribution in rat femur sections.
	 A – phosphorus distribution map, B – calcium distribution map, C – joint locations of phosphorus and calcium distribution on 

the map (joint locations of phosphorus and calcium presence are shown in yellow), D – scatter plot of phosphorus and calcium 
colocalization, E – quantitative data of Pearson’s test for phosphorus and calcium colocalization. Scale line – 2 mm

Заключение
Реализация алгоритмов, описанных в статье, при кар-

тировании химических элементов методом рентгеновско-
го микроанализа на шлифах костной ткани значительно 
расширяет возможности программного обеспечения ска-
нирующего электронного микроскопа. Сегментирование 
рентгеновских изображений элементных карт при этом 
может быть проведено как в ручном, так и в автоматиче-
ском режиме, что делает измерение концентрации в из-
учаемых областях более точным и быстрым. Больше воз-
можностей при использовании свободного программного 
обеспечения ImageJ открывается и при корреляционном 

анализе распределения двух и более химических элемен-
тов, а также при анализе их колокализации.

Предлагаемые алгоритмы могут быть использова-
ны для картирования химических элементов не только 
на шлифах костной ткани, но и на гистологических 
срезах, подготовленных криогенными методами для 
сохранения нативного содержания и распределения 
химических элементов и ионов.
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